# Table of Contents

## Chapter 1. Introduction

1.1 Why this manual. 
1.2 Why have RSTAR. 

## Chapter 2. RSTAR Capabilities.

2.1 The workstation(s). 
2.2 General features. 
2.3 Case viewing and interpretation. 
2.4 Case reporting and dictation. 
2.5 Patient and resource scheduling. 
2.6 Patient-data retrieval. 
2.7 Teaching files. 
2.8 Private-file/information maintenance. 
2.9 User tools. 
2.10 Hardcopy generation. 

## Chapter 3. The Fixed-Menu Functions.

3.1 The Fixed menus. 
3.2 The Help menu. 
3.3 The Data-access menu. 
3.4 The File menu. 
3.5 The Desk menu. 
3.6 The Schedule menu. 
3.7 The Resources menu. 

## Chapter 4. The Image-View Display.

4.1 The Image-view screen. 
4.2 The Left-side menu. 
4.3 The Right-side menu. 
4.4 Image annotation. 
4.5 The Tools menu. 
4.6 The Modify menu. 
4.7 The Advance menu.
TABLE OF CONTENTS (CONT.)

<table>
<thead>
<tr>
<th>Chapter 5.</th>
<th>The Image-Placement Display.</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>The Image-placement environment.</td>
</tr>
<tr>
<td>5.2</td>
<td>The Electronic multi-viewer.</td>
</tr>
<tr>
<td>5.3</td>
<td>The Display screens.</td>
</tr>
<tr>
<td>5.4</td>
<td>The Virtual screens.</td>
</tr>
<tr>
<td>5.5</td>
<td>Re-positioning images.</td>
</tr>
<tr>
<td>5.6</td>
<td>Saving images.</td>
</tr>
<tr>
<td>5.7</td>
<td>The Hardcopy menu.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6.</th>
<th>The File-Manipulation Display.</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>The File-manipulation screen.</td>
</tr>
<tr>
<td>6.2</td>
<td>The View menu.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7.</th>
<th>A Sample Session.</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>A Sample Session.</td>
</tr>
</tbody>
</table>
CHAPTER I. INTRODUCTION.

1.1 Why this manual

THE PURPOSE OF THIS MANUAL—which reflects the current design of the RSTAR system (Radiology Storage Transfer Analysis and Reporting)—is to elicit comments, criticisms, and suggestions from you, the future user of that system, and then to incorporate your comments into the design of a truly useful RSTAR system. For, all too often, in the design phase of a project, the engineering staff assumes that they know best what that system should do and how it should be used. Sometimes they do, but not usually.

MOREOVER THERE CURRENTLY EXISTS NO fully functional Picture Archive and Communication System in use anywhere today from which to learn; that fact makes your input even more of an imperative.

TO THAT END, we have prepared this hypothetical operating manual, one that reflects our current notions of what RSTAR should do and how the user should interact with it. We offer it as a starting place for your comments, and for continuing dialogue.

***

AND SO TO YOU, THE POTENTIAL USER OF RSTAR, we make this most earnest solicitation:

FULLY RECOGNIZED BY THE DESIGNERS of the hypothetical RSTAR system presented in this most preliminary of preliminary manuals is this: that system, however it comes eventually to be actualized, will represent a design failure, if it does not eventuate as the system OF USER CHOICE. Again we state that this preliminary manual has been prepared primarily for the purpose of providing a basis for YOUR criticisms, YOUR comments, YOUR suggestions, YOUR demurers, YOUR thoughts, YOUR ideas, YOUR whatevers. The designers believe that a very high degree of success is quite feasible, but not if your ungrudging and generous assistance is withheld.

PUT ANOTHER WAY, circumstances have here conspired to offer us all the opportunity to design RSTAR to meet the MGH radiology community’s high expectations and aspirations, and it can be done. BUT WE WILL FAIL WITHOUT YOUR HELP, YOUR INPUT.
WE THEREFORE MOST SINCERELY REQUIRE your direct input. Attached you should find a house-mail return envelope: Please use it for both your freeform and your structured responses. Also, there-with (and here, below) are telephone numbers: Please use them, any time, to ask questions, to request clarification, to discuss issues, and/or whatever seems good—or bad!—to you. And although written responses are always nice, it is possible that you may find such writing burdensome: we accept recorded conversation, dictation tapes, carved stones, computer diskettes—NO form is precluded. But by one means or another, please find a way to respond, first at once—while the material in this manual is fresh in your mind—and then also later, whenever anything else may come to mind. (Please know that a suggestion/criticism database will be maintained, to help ensure fidelity and completeness.)

***

Please do contact either Jaime Taaffe, X8785; or Rick Moore, X8358 or X8783. Thank you.

***

1.2 Why have RSTAR.

FROM THE WORDS for which "RSTAR" is an acronym, one can infer that RSTAR provides for the storage and display of digitized radiological images, much as the conventional film library stores analogue images (films), and allows those images to be communicated to those who wish to view them. In short, RSTAR is intended to become the equivalent of (but is by no means limited to the functions of) the traditional multiviewer, with its necessary file-room support.

AND MOREOVER, while RSTAR proposes to provide for reduced costs and, hopefully, improved patient care, even more importantly (taking the long view), RSTAR affords the opportunity of introducing into the radiology department the notion of the medical work station.

WHAT IS (in general) A WORK STATION? For illumination by analogy, let us briefly consider the fully developed and available engineering work station, as offered by companies such as Computer Vision, Applicon, Apollo, etc.

PHYSICALLY, the work station appears to the user as nothing more than a computer terminal: a keyboard; one (or more) screen(s) capable of displaying detailed graphics; and devices for easy drawing of and pointing to objects on the screen(s). We ignore here, just as the user does, the computer and the peripheral devices that are connected to the terminal.
THIS WORK STATION IS A REPOSITORY for all drawings, schematics, reports, etc. (radiological images, reports, etc.) that may relate to whatever problem(s) exist(s) about which the engineer-user (radiologist) needs to make decisions. The work station has been programmed to present this information both quickly and concisely to the engineer (radiologist).

THE GENERATION OF DOCUMENTATION, such as drawings and reports (annotated images and reports), is aided by the work station. The work station saves, and makes readily available, previous work, i.e., standard and/or earlier designs (interesting cases) for study or teaching or application purposes. The process of tracking the progress of work is managed by the work station, so that work, such as design write-up (dictation), is not misplaced. In essence, the work station is a multifaceted tool that helps manage the work load for the engineer (radiologist), presents this work (and a wide variety of other information) in a quick and coherent manner, and aids greatly in the preparation of any work.

THE MEDICAL WORK STATION CONCEIVED HERE is a work station that will present work to the radiologist (cases/images to be viewed) quickly, efficiently, and neatly organized; will assist the radiologist by offering a set of powerful and consistent tools for performing measurements and calculations upon images (volume, density, length, etc.), as well as valuable image-manipulation routines (edge enhancement, smoothing, etc.). [And in addition, will interface to the management and reporting systems, so as to provide patient-tracking, reporting, and scheduling functions.]

SOME REASONS for having an RSTAR work station are:

* Multi-modality viewing.
  With images from various modalities resident in a common system, it will be possible to view images of mixed modality simultaneously.

* Savings in film cost.
  With the convenience of work stations interspersed throughout the department, digital images will be less often transferred to film merely for easy viewing.

* Image security.
  With the image data residing in the computer, it is less likely for there to be missing images.

* Faster reporting
  Reporting will be faster since images will not have to be transferred to film for viewing.
* Multiple access.
With multiple workstations, many radiologists can view the same patient’s images at the same time.

* Consistent user interface.
With all images accessible via the (any) work station, the radiologist will find that he need learn but one system interface (as opposed to the current situation, with one method for viewing images on a Technicare MRI system and another on a GE CT scanner).

* Automatic case tracking.
With all cases being tracked by a properly arranged computer system, it is unlikely that a case will be lost or mislaid.

* Computerized tools
A consistent array of image-measurement and image-modification tools can be made available for all images, as opposed to some tools being available in one manufacturer’s system, and other tools in another’s.
CHAPTER II. RSTAR CAPABILITIES.

2.1 The work station(s).

Any work station can be fitted with any number of different CRT (Cathode Ray Tube) viewing screens (monitors) [for simultaneous viewing of any number of different images]. One such viewing screen will be designated the Master screen. On that Master screen, the user will indicate commands to the system, and the system will return on that screen any necessary information.

Connected to the work station is a mouse, which is a small, hand-held device that when moved along a table top causes an arrow on the screen to move in tandem. This arrow is used for pointing to locations on the screen, and, via menus on the Master screen, for invoking commands.

Optionally available at each work station will be a printer.

![RSTAR interface](image_url)
THE PRIMARY METHOD BY WHICH THE USER ISSUES COMMANDS is via drop-down menus: Along the topmost line of the Master's display will be a list of available menus. Each item (menu) listed on that line groups a related set of commands under one menu name. For example, there may be present a menu item titled 'DESK' and collected (and proffered) on this menu are all the "desk accessories," such as the clock, the calculator, the note pad, etc. (The list of available menus changes depending upon the context of current work-station usage. For example, only when viewing images is there present a menu named 'Modify', which proffers image-modification tools.)

AS AN EXAMPLE of drop-down menu use, let us consider the so-called Login sequence. On the previous page is shown the department-status menu that is displayed on the Master screen whenever the work station is sitting idle. In the central area of the screen appears the number of cases yet to be previewed, reviewed, and dictated--sorted by type of case. In the upper left-hand corner of the screen are the words 'Help' and 'Start'; these are the currently available menus. Note the arrow just to the right of the word 'RSTART'. This is the previously mentioned pointer that is moved upon the screen by moving the mouse upon the table top.

A MENU IS SELECTED BY using the mouse to move the arrow so that the arrow's tip touches any point in or on the block (on the top line of the Master screen) that contains the name of the desired menu. When that name block is touched (by the arrow's tip), i.e., when a menu has been selected, the name block darkens, and the full menu immediately "drops down," to display its list of "menu selections" (commands and/or options). In the figure shown on the next page, the Start menu has been selected and is proffering three possible menu selections:

1) Identify user-
Selecting this command initiates (on the Master screen) an identification-of-the-user-to-the-system procedure, called the Login sequence.

2) System status-
Selecting this command provides a display (on the Master screen) that is related to the system's current activity.

3) Dept status-
Selecting this command provides again the display of the department's current status, as already shown in the figure of page II-1.
A PARTICULAR MENU SELECTION IS CHOSEN by moving the arrow tip to any point on or within the box that encloses that item (i.e., 'Identify user'), and then pressing the button located on top of the mouse ('clicking' the item). Let us now click the "Identify-user" item, and thus initiate the Login sequence.

The system immediately responds (see figure on next page) by prompting the user for his (her) name. The user types in his name, and then lets the system know when he has finished typing either by clicking the 'O.K.' box on the screen or by hitting the RETURN (or ENTER) key on the keyboard.
As soon as the user has thus identified himself, the system offers a predefined choice of alternatives. (See figure below.) In the dialogue box (a rectangular window that appears on the screen whenever the user and RSTAR engage in "dialogue"), we see the system notifying the user of the existence of mail for him. (This radiologist has previously instructed the system to provide him with immediate notification of pending mail.) He may click the blackened (YES) button to read mail or, if he chooses to read films instead, he has only to click the button next to his currently assigned section, GI TOMO, and his images will appear. Or he may ask for the Main menu, discussed later.

Good morning Dr. Harris.
You have mail today.

Read Mail------------------------> YES
Access GLTomo category----->
Present Main Menu-------->
AN ALTERNATIVE METHOD IS AVAILABLE FOR INVOKING COMMANDS for those who may find the mouse inconvenient. On the workstation's keyboard, there are ten function keys labeled f1 through f10. Any menu may be selected by depressing the associated function key, and any menu item may (in turn) be selected by depressing its associated function key. (Next to the names of the Help and Start menus were shown "f1" and "f2" respectively; next to every command, item, in a menu is also an "f-number"; these indicate the associated function key.)

Note

The menus yet to be named (and discussed) on many figures below all do have associated "f-numbers," but the "f" itself, next to the name is omitted for clarity and to save space.

2.2 General features.

The facilities provided by the workstation can be divided into eight major categories:

1) Case viewing and interpretation.
2) Case reporting and dictation.
3) Patient and resource scheduling.
4) Patient data retrieval (Broad data base functions).
5) Teaching files.
6) Private file/information maintenance.
7) User tools.
8) Hardcopy generation.

There follows a brief, introductory exegesis of each of these facilities.

2.3 Case viewing and interpretation.

The primary function of the RSTAR system is image viewing. Thus, the system provides a large array of services for displaying and manipulating images:

* The system can display any image from the digitized patient data base, regardless of modality, including cine images. In addition, multiple images may be displayed seriatim upon any screen (monitor), "in parallel" on multiple monitors, and, of course, in mixed modalities.
* The system allows the typical range of computerized image manipulations, i.e., pan, zoom, rotate as well as the usual range of computerized image transformations, such as edge enhancement, image smoothing, etc.

* The system allows the user easily to perform measurements upon the images, i.e., length, density, area, etc.

* The system provides a full range of image marking and annotation facilities.

* A full range of mark-region-of-interest facilities are provided: circle, square, point, etc.

2.4 Case reporting and dictation,

* The system will be connected to the department's reporting system allowing old reports to be accessed and new reports to be entered, as desired, from the work station. This feature in no way precludes verbal dictation using existing systems.

2.5 Patient and resource scheduling,

* Due to the connection between RSTAR and the reporting system, it will be possible to have exams scheduled from a work station and there to check for possible conflicts.

* Users will at any time be able to view the currently available department resources.

2.6 Patient-data retrieval (Broad data-base functions).

As ever more cases are processed via the RSTAR system, it will become ever more imperative that the work station provide facilities for easy access to this data. In line with this requirement, RSTAR provides many methods by which a case may be selected for viewing:

* Automatically, RSTAR presents to the user those cases for which he is currently responsible. RSTAR does this by having in its data base the association between the user's name and the user's section responsibility (Bone CT, GI, etc.). (The presentation is made on one, or multiple, screen(s) as required, detailed discussion later, by using RSTAR as a computerized equivalent of a multi-viewer.)
* The user can select a particular case, either by patient's name or by medical record number. Incomplete names or numbers are acceptable; in which case RSTAR will present a list of all those patients matching the incomplete description.

* Users can select groups of patients by querying the database using natural language (everyday English). For example, "Please get all patients 50 years old or older having CT scans of the lumbar region." RSTAR will then get these cases and place them in an electronic file folder ready for viewing. (RSTAR "parses" English; no "computerese" is required.)

### 2.7 Teaching files.

The patient data and images in the RSTAR database constitute an invaluable source for creating teaching files. RSTAR provides numerous methods by which such files can be created, maintained, and viewed. In addition, the cases in the teaching files can contain detailed annotations and notes.

Patients can be selected for inclusion into a particular teaching file by using any of these three access methods:

1. When any image is being viewed on the computerized multi-viewer, the associated patient file can be marked for inclusion.
2. By name or medical record number.
3. Selection by a natural-language query of the database.

For security, cases can be placed into a teaching file only by a staff member.

### 2.8 Private-file/information maintenance.

Just as radiologists now keep private files of interesting cases, RSTAR also allows for private files to be maintained on the system. These files may consist of patient cases, patient reports, old and new notes, memos, mail, etc.
2.9 User tools.

We all have various 'tools' on our desks, such as those for taking notes, making calculations, scheduling appointments, etc.

It is reasonable (and extremely convenient) that the work station provide such tools. Thus RSTAR provides:

1- Mail functions, 2- Memos capability, 3- A Digital clock, 4- Electronic reminders, 5- A Department events listing, 6- System news, 7- Calendar and appointment-scheduling functions.

2.10 Hardcopy generation.

RSTAR provides for the printing of textual material, and for the generation of slides and films of images (with annotations).
CHAPTER III. THE FIXED-MENU FUNCTIONS.

3.1 The Fixed menus.

The RSTAR work station will generally be used in either of three different contexts. They are image viewing, image placement, and file manipulation. Each of these contexts offers (in general) a different list of menus; however, six menus are listed on the screen in every one of the three contexts. This chapter discusses the functions of these six "fixed" menus shown just below.

Help1 Access2 File3 Desk4 Schedule5 Resources6

3.2 The Help menu.

The always available Help menu offers online assistance. As shown below, the Help menu offers three choices:

Help1 Access2 File3 Desk4 Schedule5 Resources6

<table>
<thead>
<tr>
<th>General introduction</th>
<th>f1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online user manual</td>
<td>f2</td>
</tr>
<tr>
<td>Specific questions</td>
<td>f3</td>
</tr>
<tr>
<td>Quit</td>
<td>f4</td>
</tr>
</tbody>
</table>
General introduction-
This item displays a few pages (screenfuls) of general information about how the system functions in the current context. For example, if invoked while the system is displaying the "idle" screen, 'General information' will offer information concerning the department-status and how to log on to the system, but if it is invoked while displaying images, then information about the capabilities available for image manipulation, image transformations, etc. will be offered.

Online user manual-
This item offers the user the ability to display any or all portions of the RSTAR manual. The user will be offered first a table of contents and then, based on selections made therefrom, the desired portions of the manual will appear.

Specific questions-
Selection of this item will enable the user to ask specific questions about the system in plain English and to receive specific answers. The system will tolerate large variations in the form of the questions—RSTAR parses English. Some examples are:

How do I find ...
Do I need to ...
What should I do to ...

The two figures below demonstrate this feature. The first figure shows a dialogue box in which the user's typed question ("How do I get a slide made?") is repeated on the screen ("of an image is assumed by RSTAR").
The next figure shows RSTAR's response, a detailed prescription for reaching the goal. Note, the user has clicked the 'YES' button.

If the answer was not helpful, the user may indicate this by clicking the 'NO' button. Then the system will try, by posing a question to the user, to direct the user to the appropriate section of the online user manual.

1. Select the desired image. You may use the Main-file-room command from the main menu.

2. Then use the Make-slides command found under the Hardcopy menu that is available when doing manual placement of images.

Was this helpful? [YES] [No]
3.3 The Data-access menu.

The Access menu allows the user to select among suitable portions of RSTAR's data base. Specifically, choosing a particular menu item instructs the system to show either a culled and sorted subset of the patient data base, usually cases still in process in the department, or some other files. The menu below shows the five possible choices.

```
Help1 | Main2 | File3 Desk4 Schedule5 Resources6

My dictation stack 11
Main file room 12
Case sections 13
Teaching files 14
My private files 15
Patient Reports 16
```

My dictation stack-
Choosing this option instructs the system to display those cases belonging to the radiologist currently using the system.

Main file room-
This option allows either a particular patient or a related class of patients to be accessed from the main file room.

In the figure below we see a dialogue box in which the user has responded to the system's request for a particular patient's name or medical record number.

```
Please enter the patients name or medical record number. Use a ? for a missing character and a * for a missing part of a word.

NAME/NUMBER --> Doe, J*

OK. CANCEL
```
Note that the user responded with an incomplete patient name. Thus, the system presents to the user those names that partially match, and then leaves the choice to the user. This is shown in the figure below.

![Figure showing a list of matched patient names and a radio button for selection]

Also, the system lets the user select patients by using a natural-language query. In the figure below, we see the radiologist requesting in English that the system collect files on all patients meeting certain requirements.

![Figure showing a text box for search request]

Please enter your search request.

Find all patients 25 years old or older who have the diagnosis osteoporosis and have had CAT scans.

![Radio buttons for OK and Cancel]
The system responds, as we see in the next figure, with the number of patients it has found plus a summary of its interpretation of the previous natural-language request.

The search found 203 patients with the following attributes.

- Age greater than or equal to 25.
- Diagnosis was osteoporosis.
- Exam type was CAT scan, unspecified.

Save these records in your Private-files?

[OK] [No, more] [CANCEL]

Case sections-
The system is able to sort current cases many ways (for example, by type of study, i.e., GI, bone, pediatric, etc.; by modality, i.e., CT, MRI, etc.; etc.), although it usually presents to the user the section to which he is currently assigned. This option allows the radiologist to choose which case section will be presented on the multi-viewer.

(This RSTAR usage not currently illustrated.)

Teaching files-
Various teaching files of public interest may have been constructed by staff. This option proffers access to such case studies.

(This RSTAR usage not currently illustrated.)

My private files-
As users find interesting cases, they can file (copies of) them in private file folders for later study. This option is one of several ways for accessing these files. By invoking this option, the user is temporarily taken to the 'File-manipulation screen' which will be discussed in Chapter VI.

(This RSTAR usage not currently illustrated.)
Patient reports—
This option proffers patient reports by three categories: radiology, microbiology, and pathology. (Radiology reports selected by the user can be edited.) Below we see the dialogue box in which the user is asked to choose one of those categories.

Please check the desired report.

- Radiology
- Microbiology
- Pathology
- General Patient information

[O.K. Cancel]
3.4 The File menu.

The File menu, shown below, contains a collection of commands for creating and manipulating files. The commands fall into three categories:

1) Creating new files from the data base,
2) Transferring information between files,
3) (Functions for) maintaining files.

<table>
<thead>
<tr>
<th>Help1 Access2 File5 Desk4 Schedule5 Resources6</th>
</tr>
</thead>
<tbody>
<tr>
<td>New patient</td>
</tr>
<tr>
<td>Data base search</td>
</tr>
<tr>
<td>Save current display station status</td>
</tr>
<tr>
<td>Clear clip board</td>
</tr>
<tr>
<td>Cut clip board</td>
</tr>
<tr>
<td>Copy clip board</td>
</tr>
<tr>
<td>Paste clip board</td>
</tr>
<tr>
<td>File manipulation</td>
</tr>
<tr>
<td>Duplicate file</td>
</tr>
<tr>
<td>Delete file</td>
</tr>
</tbody>
</table>
1) **File-creation commands.**

**New patient-**
Like the "Main-file-room" command in the Access menu, this command allows for patients' Master Folders to be accessed, but here, images are not immediately displayed. Instead, a copy of the Master folder is placed into the user's private files.

**Data base search-**
Here the user can search the data base using a natural-language query; a copy of the resultant data is placed into the user's private files.

(\*This RSTAR usage not currently illustrated.\*)

**Save current display & station status-**
With this command, the user is able to save the current state of the display on the screen(s) and the entire status of the work station as it was at the moment this command was invoked. That is, "the present situation," with whatever images are currently being displayed, with any new annotations, any open reports, etc., will --in its entirety-- be saved in the user's private file. (One purpose: the current user can pass use of the work station to another user, knowing that he can later instantly and easily return to his work with the work-station situation exactly as it was when he stopped prior use.)

2) **Clip board commands.**

The Clip board is a temporary repository for information and makes possible transfer of information from one document to another. For example, to transfer a portion of a pathology report into a memo, or into a radiology report, the user selects the desired portion of the pathology report and Cuts that portion (removes it from the original, and transfers that portion TO the clip board). Later, the user Pastes (copies FROM the clip board) to memo or report. The user may also Copy (without removing) something from an original to the clip board.
3) File functions.

File manipulation-
Selection of this item causes entry into the File-manipulation menu to be discussed in Chapter VI.

Duplicate file-
Causes the selected file to be duplicated.

Delete file-
Causes the selected file to be deleted. Only user files may be deleted, never original patient files.

3.5 The Desk menu.

Various Desk tools are available for use at any time. The tools are things found on many desks, such as: a calculator, a memo pad, a clock, etc. This menu allows the user to select a particular tool.
Mail -
This command causes the system to display a listing of all received and unread mail addressed to the (logged-on) user. In addition, the user is presented with various options: read, save (i.e., maintain old mail in a file), delete, and return mail items, as desired.

You have 4 pieces of mail. Pick those you wish to read.

<table>
<thead>
<tr>
<th>From</th>
<th>When sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Al Williams</td>
<td>2/01/85</td>
</tr>
<tr>
<td>John Smith</td>
<td>2/02/85</td>
</tr>
<tr>
<td>Peter Moore</td>
<td>2/04/85</td>
</tr>
<tr>
<td>Don Oak</td>
<td>2/04/85</td>
</tr>
</tbody>
</table>

[Image of mail interface with options to read and send]
Calculator -
This command causes a simple calculator to be made available. The user can use the pointer, as controlled by the mouse, or the numeric keypad found on the work-station's keyboard, to manipulate the calculator. The functions of this calculator include squareroot, memory(+) , and memory(-).
Clock -
The clock functions like an ordinary digital clock and shows the current date and time. After being called up, it can be placed in any desired position on the screen, and left there, until the user issues a command to move or remove it.

□ Tue Feb 26, 1985 3:34:05 PM

Alarm -
This tool lets the user set an electronic alarm to act as a reminder. At the appropriate time, the alarm will beep and present a pre-set, user-defined message that reminds the user why the alarm has sounded. The user is allowed to pre-set as many different times/messages as desired.

The setting of the time can be specified in three different ways:

1- absolute time, e.g., 13:23 (24 hours), or 1:23PM (AM/PM),
2- relative time, e.g., NOW + 20 minutes,
3- count down, e.g., AFTER 20 (again 20 elapsed minutes, but a different display format).

Timer

Time 3:45 PM

Message New employee orientation.

START CANCEL CAN/ALL

Timer can be set as: absolute 1:20 PM
relative NOW + 20
Count down After 45.
Memo pad —
This command invokes a memo utility. The user can make multiple memos of arbitrary length and keep them in his private files. The various options offered are: make a new memo, save a memo, and review an old memo.

---

Dear Dr. Charles:

As per your request Dr. Franks and I met to discuss the Rick's case. We agree with your report of 2/6/85.

Yours truly,

Drs. Smith & Frank
Today's Events –
This command causes the system to display a list of the department events scheduled for the day. The user can select from among these some, all, or none that are to be entered into his personal calendar. For selected events, the system can be instructed to flash a reminder on the screen a few minutes before the scheduled time of the event(s).
Calendar -
This command not only offers a calendar (perpetual), but also an associated appointment book. Appointments can be scheduled up to one year in advance with old appointments kept for up to six months. In addition, when the appointment book has "been opened," the scheduled events for the department are also shown.
System News -
When this command is invoked, the system will display all system news and announcements.

Who -
This command displays a list of all current users on the system. The information displayed includes names, locations, and telephone extensions. In addition, the locations of all free work stations will be displayed.
RSTAR is linked to the Department’s scheduling system. Thus, the user may operate the scheduling system from the workstation. The menu below shows the commands that invoke the various scheduling functions.

Schedule exam—Using this command, patients may be scheduled for exams. (One may check for possible exam conflicts.)

Schedule room—This command allows for rooms to be allocated for various purposes.

List pending exams—Scheduled exams, and possible conflicts, are listed by this command.
3.7 The Resources menu.

This menu allows the user to shape to his preference the "manner" in which the system performs for him:

<table>
<thead>
<tr>
<th>Help1</th>
<th>Access2</th>
<th>File3</th>
<th>Desk4</th>
<th>Schedule5</th>
<th>Resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>System configuration f1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Logical configuration f2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>User defaults f3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>?? f4</td>
</tr>
</tbody>
</table>

System configuration-
This command is used to inform the system of any changes made in the hardware configuration of the work station (for example, that a local printer has been connected or that an additional display screen has been connected). Here the user informs the system that he (the user) has changed the work station, and in what manner.

Logical configuration-
The system has many aspects that are user tailorable. Among these aspects are: screen layout, file-hierarchy structure, private-file access permissions; and many other small, but important, relationships between physical entities and "logical" entities. (More details later.)

User defaults-
Certain defaults, such as presentation order of cases, priority of mail viewing, etc., are definable by the user. This command presents a table of defaults to be set by the user.
4.1 The Image-view environment.

Note

In Chapter III, paragraph 3.1, we said that the "... RSTAR work station will (generally) be used in either of three different contexts: They are image viewing, image placement, and file manipulation. ..." In the present chapter, we discuss the first of those contexts, here labelling that context "the Image-view environment."

THE RADIOLOGIST WILL SPEND MOST OF HIS LOGGED-ON TIME in the Image-view environment (using the Image-view display on the Master screen). For it is in this environment that images are displayed, measured, annotated, modified, etc. Additionally, here, case dispositions can be updated and changed.
The figure on the previous page shows, across the top of the Master screen, a list of now-familiar and some new drop-down menus. In addition to those drop-down menus, there are, along the left side of the screen and, less obviously, along the right side of the screen, menu items for the most-often-used commands.

Unlike the drop-down menus, a side menu appears (and overlaps a small portion of the image-viewing area of the screen) only when the pointer is moved, using the mouse, into the area of any part of the side menu. One has then only to click a particular box (menu item) in a side menu to effect that command. For example, to "zoom in on" an image shown on the Master screen, one need only click the box labeled 'In' (left-side menu).

4.2 The left-side menu.

The left-side menu is divided into four sections. They are, from top to bottom:

* Five image-presentation commands.

In-
This command causes the presentation to "zoom in" on the image providing a linear magnification of 2X.

Out-
Causes the presentation to zoom out from the image causing a linear decrease in magnification of 2X.

Rotate-
This command rotates the displayed image. The amount and direction of rotation is controlled by the mouse as follows: if the mouse is moved with a-left-to-right motion, the image will rotate in a clockwise direction (the amount of the rotation being proportional to the amount of movement of the mouse); conversely, a right-to-left motion of the mouse produces a proportionate counterclockwise rotation of the image.

Flip-
This command causes the image to be flipped over about the vertical axis (to be inverted, left-to-right).
Pan-
This command causes the display to "pan," to change so that parts of the image disappear from one region of the boundary of the presentation while new portions of the image appear at the opposite region of the boundary. The part of the image that is displayed moves along with the movements of the mouse.

* Three simple image tools.

Ruler-
When this command has been invoked, the user has only to click any two points on the screen in order to have the work station automatically draw a line between those points and label the line with the distance between the points. These markings (line plus distance) remain on the screen, superimposed upon the image, until the user removes them by dragging them off the screen with the mouse. Any number of rulers can be placed upon the screen.

Protractor-
To find the interior angle between two line segments, the user has only to invoke this command, and then to define two lines by clicking their four end points. The work station will then display the interior angle. As with the ruler command, an arbitrary number of angle measurements can reside upon the display.

Perpendicular-
To have the work station draw (drop) a perpendicular line, it is only necessary to invoke this command, define the first line segment by clicking the associated end points, and then click the desired starting point of the perpendicular. Again, an arbitrary number of perpendiculars can be drawn upon the screen.

* Six Region-Of-Interest markers.

The system offers six region-of-interest markers, as indicated by the six items grouped under the heading ‘R.O.I’. They are: square, rectangle, circle, point, arbitrary line, and arbitrary polygon. The placement and extent of an ROI is controlled by the mouse. For example, to form a square or a rectangular ROI, one clicks the command, and then clicks the upper left-hand corner of the ROI and the lower right-hand corner.
If "ROI statistics" has previously been set to "ON" in the Resource menu, to be discussed later, then the workstation will report various selected statistics concerning each of the ROI(s) selected above, such as volume, area, mean, etc.

* Screen items.

`NEXT` AND `LAST`. A particular case file usually has in it many more images (films) than can be displayed simultaneously on the available screens. Because of this limitation, the workstation presents the images in batches where the number of images in a batch is dependent on the number of monitors, the modality, the type of exam, etc. The 'Next' and 'Last' commands cause the workstation to display the next or last batch of images.

THE `PLACE` COMMAND causes the workstation to go to the Image-placement screen (to be discussed in Chapter VI), to allow functions such as the manual placement of images on particular screens, etc.

### 4.3 The right-side menu (sliders and presets).

Just as there are controls on conventional display stations to control such factors as image window, center, base, etc., RSTAR also provides these controls in the form of graphic sliders. For example, we see on the upper right-hand side of the view screen a slider marked 'Window'. By moving the "handle" (oval marker) up and down with the mouse, the display window is set. The Resources menu permits the user to decide which slider controls are to be placed upon the view screen.

Located just below the sliders are four user-setable "presets", PS1 through PS4. An individual preset is set to "hold" the current settings of all the sliders by clicking that preset twice, quickly, with the mouse. To cause a particular preset's values to be transferred to (all) the sliders, the user need only click the preset once.

### 4.4 Image annotation.

TO ANNOTATE AN IMAGE, the radiologist need only place the pointer on the desired spot in the image, click, and start typing. The type style and size (font) can be changed by using the Resource menu. For those special symbols that are needed, such as arrows, RSTAR provides a complete set. They are accessed by depressing and holding the 'ALT' (alternate character set) key on the keyboard and then depressing a second key. For example, to place an up arrow on the screen, depress the 'ALT' key and then the up-arrow key.
4.5 The Tools menu.

Discussed briefly below are just a few of the tools that will be offered under this menu. It is intended that as time passes a more extensive set of tools will evolve. In particular, the designers have in mind tools utilizing quite advanced computer developments in the fields of artificial intelligence and expert systems.

![Tool options]

**Volume**
From a series of CT images that bound a particular object, for example, a lung, the system will calculate the volume of the object.

**Calcium density**
For both plain films and CT images, the system will calculate the calcium density of an indicated bone. The bone and the density reference can be marked using any of the region-of-interest markers.

**Reconstruct**
This command causes the system to perform CT reconstructions.

**Expert system- Bone cancer**
As MGH already has a developed expert system for bone cancer diagnosis, it will be the first of many (we trust) expert systems made available.
4.6 The Modify menu.

This menu offers a broad spectrum of image-modification routines. Shown below are just a few of the commands available; as need arises, many more routines will be made available.
4.7 The Advance menu.

A primary reason for RSTAR is the facilitation of the movement of cases through the department. There then must be available a series of commands for updating the disposition of the case currently being viewed. These commands are grouped under the ADVANCE menu. RSTAR places the cases in process within the department into three ordered (1st, 2nd, 3rd) categories:

- **To preview:** These are cases that have had exams performed but have yet to be viewed by residents or staff.
- **To review:** These cases have been previewed by a resident but await staff review.
- **To dictate:** In this category are placed cases checked by staff and awaiting dictation.
Log & advance case-
This command advances the viewed exam to the next category, logs the physician's name to the case, and causes the next case to be presented. For example, if a resident is viewing a case for the first time, then this command will advance the case to the waiting-for-review category.

Skip case-
The skip-case command causes the presently viewed case to be placed back onto the electronic multi-viewer with no change in disposition, and causes the next case to be presented.

To preview-
To review-
To dictate-
To done-
There are many instances where the normal flow of a patient's case through the department must be interrupted. These four commands allow for a case to be placed into a particular category regardless of its current disposition.
CHAPTER V. THE IMAGE-PLACEMENT DISPLAY.

5.1 The Image-placement environment.

Note

In Chapter III, paragraph 3.1, we said that the "... RSTAR work station will (generally) be used in either of three different contexts: They are image viewing, image placement, and file manipulation. ..." In the present chapter, we discuss the second of those contexts, here labelling that context "the image-placement environment."

OUR EARLIER DISCUSSION OF THE IMAGE-VIEW ENVIRONMENT (Chapter IV) contained the implication that RSTAR contains a comprehensive system of rules that enables RSTAR to place medical images (from any case folder under consideration) onto the work station's monitors in a manner similar to the manner in which a file librarian sorts images to a traditional multi-viewer. Additionally, those rules will find, and arrange to display, any comparison films that may be in the case folder in question.

OCCASIONS WILL ARISE on which the radiologist viewing a case will wish to alter RSTAR's placement of images, perhaps a number of times and in a number of different ways. It is the Image-placement environment, which we discuss here, that provides to the radiologist complete flexibility to re-position images, i.e., to adjust image placement, in accordance with his exact requirements.

In the figure on the following page we see the Image-placement display. In this example, the work station is fitted with three monitors, and a resident is working through his stack of cases to be dictated.
The image-placement screen contains three main areas:

1- The Electronic (computerized) multi-viewer.
2- The Display screens.
3- The Virtual screens.

Each of these areas will now be discussed.
5.2 The Electronic multi-viewer.

**OCCUPYING THE LOWER HALF OF THE IMAGE-PLACEMENT SCREEN** is a rectangular area reminiscent of a conventional multi-viewer. The left-hand side of this multi-viewer displays basic patient information, such as name, date of birth, exam date, etc.

**Note**

More extensive patient information is provided by the Patient Reports command in the (drop-down) Access menu.

**ON THE MULTI-VIEWER ARE REPRESENTATIONS** of the available films. In this example, we see 10 representations of CT images of the HEAD. Depending on the exam type, the representations may be drawings (schematics), miniatures (low-resolution images), or text descriptions (as in this example).

**TO OBTAIN DETAILED INFORMATION ABOUT A PARTICULAR IMAGE** on the multi-viewer, it is only necessary to "double click" that image and a dialogue box containing that information then appears.

**ON THE RIGHT-HAND SIDE OF THE MULTI-VIEWER ARE TWO ARROWS**, one pointing up, and the other down. Respectively, these arrows, when clicked with the mouse, cause the previous, or the next, panel of images to appear (as with a conventional multi-viewer). In addition, to move quickly, scroll, through the panels, the 'SCROLL BAR'—the dark square between the up and down arrows—can be moved with the mouse. Sliding the scroll bar up causes previous panels to be rapidly displayed, while sliding the bar down rapidly displays panels from cases lower on the stack.

**LASTLY, A LINE OF TEXT JUST ABOVE THE MULTI-VIEWER** tells which case number, out of the (also displayed) total number of cases, is presently being shown on the multi-viewer.
5.3 The Display screens.

IN THE UPPER LEFT-HAND-CORNER of the Image-placement screen is located a pictorial representation of the physical arrangement of the work station's currently available monitors. (This representation can be adjusted by the user—using the Resources menu—to accurately depict the physical layout of the monitors.) The figure shows that this work station contains three monitors in a single row. Notice the numbers appearing within the representative monitors. These numbers correspond to the images on the electronic multi-viewer, and thus indicate just how the images from the multi-viewer will be displayed on the monitors. Furthermore, if more than one number appears within a monitor (notice the third screen in the example), the several numbers indicate that more than one image will be displayed on the monitor, and which ones.

If RSTAR is able to find comparison films in the patient’s master folder, it will display these films as indicated by the text above the third screen.

5.4 The Virtual screens.

As mentioned in our discussion of the Image-viewing environment (Chapter IV), the Next command (of the left-side menu) instructs RSTAR to display the next batch of images. It is these Virtual screens that indicate what will be contained in “the next batch” (the numbers within the Virtual screens corresponding to the image numbers on the multi-viewer). Referring to our example here, when that Next command is clicked (on the Image-view screen), images 3, 4, and 5—indicated on the Virtual screens—would fill the actual display monitors.

5.5 Re-positioning images.

To cause a particular image from the multi-viewer to appear on a particular monitor is as simple as “selecting it” with the mouse (clicking the image), and then selecting the representation of the desired monitor. For example, suppose the user desires that image number 5 be displayed on the left-most monitor, he has but to do the following:

1) Click the desired image (number 5 on the multi-viewer), with the mouse. That image will then start flashing.

2) Click the desired (left-most) monitor. The film number, 5, will now appear in the representation of the monitor.
The forgoing two steps may be repeated as many times as desired, and apply both to the Display screens and to the Virtual screens. Images may also be moved between the Display screens and the Virtual screens. When the user has made all desired placements, he can view the images he has selected--on the actual monitors--by clicking the "View" button located at the lower right-hand corner of the Image-placement screen.

Clicking the "Cancel" button will return the user to the Image-viewing screen with all the changes made above undone, cancelled.

5.6 Saving Images.

To create a private file of images, the user need only pick up the image(s) with the mouse and place them on the file folder located in the upper right-hand corner of the image placement screen (as described in the next paragraph). This will cause a copy of the image to be placed in the file folder. Images can be picked up from the multi-viewer, the Virtual screens, or the Display screens. Images that have annotations, or region-of-interest markings, on them will be saved with those annotations.

To save (copy) one image to the file folder, just click the desired image. As with the move-image-to-Display-screen procedure, the image will commence to flash; then click the file folder.

To save a group of images, the user can "pull a box" around them. The images contained within the "box" will be placed into the file folder. For example, to pull a box around the Display screens the user would:

1) place the pointer, via the mouse, on the upper left-hand corner of the first Display screen;
2) depress the button on the mouse; and,
3) while holding the button down, draw the pointer diagonally down and across the three screens (causing a box to appear, grow, and encompass the screens);
4) then, when the box encloses all desired screens, release the button.

The selected images will begin to flash; the file folder is then clicked.
The file folder can have a name attached to it at any time. To name a file folder, the user clicks the file folder, and then types the desired name, followed by pressing the [RETURN] or [ENTER] key. If the desired "name" is simply the patient's name and today's date, no typing is required. Just click the folder and hit [RETURN].

The contents of the file folder can be examined by clicking the folder twice. This causes the file folder to "open", showing its contents. Additional file folders are available via the RESOURCE menu.

5.7 The Hardcopy menu.

RSTAR provides for the creation of various hard-copy media. The HARDCOPY menu, shown below, provides for printing patient reports and for producing slides and films. (Hard copies of images that have been annotated retain the annotation.)
CHAPTER VI. THE FILE-MANIPULATION DISPLAY

6.1 The File-manipulation screen.

Note

In Chapter III, paragraph 3.1, we said that the "... RSTAR work station will (generally) be used in either of three different contexts: They are image viewing, image placement, and file manipulation. ..." In the present chapter, we discuss the first of those contexts, here labelling that context "the File-manipulation environment."

Just as within a conventional file system various maintenance functions are required, such as labeling new file folders, filing new information, etc., such functions can also be performed within RSTAR. These functions include:

1) The placement (filing) of files into various folders;
2) The creation of new file folders, or other folders, into which to place files;
3) The listing (cataloging) of private files;
4) The deletion of unwanted files; and,
5) The renaming of files as necessary.

On the following page is shown the File-manipulation screen displaying 'Dr. Harris's private files.' In this display are various file folders containing interesting cases, patient master-folders, radiology reports, etc. By example, using Dr. Harris's files, some of the functions mentioned above will be illustrated:
Filing
Located on the screen is a figure (icon) representing a number of annotated images of the patient, John Smith. (This case folder was created by Dr. Harris when viewing films earlier.) Dr. Harris has decided that this is another interesting upper GI case and wishes to file it with other related cases. Notice an icon in the shape of a file folder that is labeled "Interesting upper GI’s." To file John Smith’s case in this folder, the following is done:

1) Click the case file, causing it to be selected and thus blink.

2) Click the file folder of interesting cases. This causes the blinking case to be placed within the file folder.

In addition to placing files in folders, folders themselves can be placed within other folders. Thus, the user is able to construct a hierarchical file system. The figure on the following page illustrates this concept.
A hierarchical file structure is schematized in the drawing above. The file structure starts with one folder named "Bone tumors-Chondrosarcoma-Pelvis and sacroiliac".

Contained within this folder are three other folders that segregate the information into three modalities: CT, plain films, and MRI.

Looking at the CT folder, we see that it contains two folders that further subdivide the data into Pelvis and Hip cases. Lastly, we see that contained within the Pelvis folder are three patient master folders that contain cases exemplifying CT images of the pelvis where the disease is chondrosarcoma.

Thus, this "descending" (hierarchical) structure provides a means by which information (images, mail, memos, etc.) can be filed in a simple and logical manner.
To view the contents of a file folder, the user has but to double click the folder which causes the folder to "open up." In the file-manipulation figure, we see the contents of an open folder labeled "To show Dr. Smith". This folder contains 2 patient master folders and 1 radiology report. To close the folder, the small square in the upper left hand corner is clicked.

If a copy of a file, or of an entire folder, is desired, the user can find provided under the FILE menu the command "Duplicate file", which when clicked will duplicate the selected file or file folder. Again, the selection of the file to copy is done by clicking it. Also, selection can be made of a number of files by pulling a box around them in the same manner as moving images in the image-placement screen.

Folder creation
When new unlabeled file folders are needed, the user accesses the RESOURCE menu and clicks the the appropriate command.

File deletion
File deletion can be accomplished in two ways. One, selecting the files with the mouse and using the Delete file command offered under the FILE menu. Two, selecting the desired files and placing them in the trash can located in the lower left of the file-manipulation screen.

File Renaming
To rename a file or folder all the user has to do is:

1- place the pointer, via the mouse, onto the existing file or folder name;

2- click the mouse, causing the name to be highlighted;

3- and type in the new name, depressing [RETURN] or [ENTER] when done.

6.2 The View menu.

The VIEW menu (figure on the next page) contains a number of commands which control how files are presented to the user. The commands are grouped into 3 logical categories. Within each category, one of the particular options is selected by clicking it.
Icon-
Text-
This set of options controls how files are visually presented to the user. Normally, RSTAR represents files, and file folders, with icons (pictorial representations). For example, the objects on the File-manipulation screen are shown as icons. There is another format for displaying files, and that is by 'Text'. In the Text mode, files are listed, in the more conventional computer manner, one per line, with each line consisting of file name, size, date and time of creation, and (if image data) modality.

Order by date/time-
Order by name-
Order by mode-
For cases presented on a multi-viewer, or files displayed in the Text mode, the order of presentation can be controlled with this group of commands. In effect, these commands cause the files to be sorted by either date/time, file name, or modality.

Display all-
Display preview only-
Display review only-
Display dictate only-
For cases being viewed on a section multi-viewer, these options cause only those cases selected to appear. For example, if 'Display dictate only' was selected, then only cases needing dictation will appear on the multi-viewer.
Chapter VII. A SAMPLE SESSION.

-> Ruth gets started

Although this was her first day reading at the CT-bone RSTAR terminal, Dr. Ruth Recheque, a Radiology resident, has been reading at the other RSTAR terminals for three months now. Sitting down, glancing at the screen, she notices that six cases are waiting for her preview in the spine-CT section. It is also clear that her good friend, Dr. Sam Secondguess, has his work cut out for him; neuro is really busy today.

<table>
<thead>
<tr>
<th>Section</th>
<th>Pre.</th>
<th>Rev.</th>
<th>Dic.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bone Plain films</td>
<td>12</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Bone CT's</td>
<td>33</td>
<td>11</td>
<td>5</td>
</tr>
<tr>
<td>Bone Tomos</td>
<td>3</td>
<td>23</td>
<td>3</td>
</tr>
<tr>
<td>Bone MR</td>
<td>45</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>GI Plain films</td>
<td>11</td>
<td>23</td>
<td>4</td>
</tr>
<tr>
<td>GI CT's</td>
<td>32</td>
<td>33</td>
<td>6</td>
</tr>
<tr>
<td>GI Tomos</td>
<td>11</td>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>GI MR</td>
<td>7</td>
<td>33</td>
<td>5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Pre.</th>
<th>Rev.</th>
<th>Dic.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuclear</td>
<td>1</td>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>Neuro.</td>
<td>13</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>Spine-CT</td>
<td>6</td>
<td>6</td>
<td>3</td>
</tr>
</tbody>
</table>

**CASES OVER 24 HOURS OLD**

To preview 4. To review 7. To dictate 10.

Time 12:35PM
Date 02/23/85
The Neuro-CT section, to which Sam is assigned, shows a 13 case backlog to read out. "Better get started", she mutters, moving the MOUSE to place the POINTER ARROW on the START box. As the pointer touches the START box on the screen, a short list of choices appears below the START box, covering part of the RSTAR logo and a little of the department workstatus display.

<table>
<thead>
<tr>
<th>Section</th>
<th>Pre.</th>
<th>Rev.</th>
<th>Dia.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bone Plain films</td>
<td>12</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Bone CT's</td>
<td>33</td>
<td>11</td>
<td>5</td>
</tr>
<tr>
<td>Bone Tomos</td>
<td>3</td>
<td>23</td>
<td>3</td>
</tr>
<tr>
<td>Bone MR</td>
<td>45</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>GI Plain films</td>
<td>11</td>
<td>23</td>
<td>4</td>
</tr>
<tr>
<td>GI CT's</td>
<td>32</td>
<td>33</td>
<td>6</td>
</tr>
<tr>
<td>GI Tomos</td>
<td>11</td>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>GI MR</td>
<td>7</td>
<td>33</td>
<td>5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Pre.</th>
<th>Rev.</th>
<th>Dia.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuclear</td>
<td>1</td>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>Neuro.</td>
<td>13</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>Spine-CT</td>
<td>6</td>
<td>6</td>
<td>3</td>
</tr>
</tbody>
</table>

CASES OVER 24 HOURS OLD

To preview 4. To review 7. To dictate 10.

Time 12:35PM
Date 02/23/85
Ruth identifies herself to RSTAR

Ruth wants to read cases immediately, so she moves the pointer next to IDENTIFY USER, and clicks the button on the top of the mouse. Immediately, a dialogue box opens, expanding to fill the bottom middle of the screen. The system is requesting Ruth's user identification.

After identifying herself satisfactorily, Ruth moves the pointer to the OK circle within the dialogue box. Clicking the mouse causes a greeting to appear: "Good afternoon Dr. Recheque, you have no mail just now." Underneath, three choices have appeared with three selection boxes. "They think this makes computers friendly," she laughs to herself.
→ Finding out what's in the work-stack

By moving the pointer to **bone-CT** and clicking the mouse button, Ruth sends RSTAR into the "stack-preview" mode automatically. In this mode RSTAR presents, serially, each case from the top-preview stack. Ruth can now read, comment, analyze, and otherwise prepare cases for later staff review.

Good morning Dr. Recheque.
You have no new mail today.

Read Mail----------> 

Access Bone-CT category--> YES

Present Main Menu------>

After selecting bone-ct RSTAR, the terminal displays the first set of images for the case that is on the top of the stack.
Automatic case presentation

The particular RSTAR workstation that Ruth is using has three display screens (or monitors). The first four images of the CT series occupy the left hand screen; the next four appear in the center Image view screen, and the next four on the right screen.
Access to image sequences

"There really doesn't seem to be anything wrong here", she mutters, after scanning the lumbar slices, "but I need to see the rest of these cuts to really be sure." By clicking the NEXT IMAGE icon (in the lower left hand portion of the screen) with the mouse pointer, Ruth causes the next set of sixteen images to be displayed, replacing the previous sixteen. With one more click she has what she is looking for: a lumbar vertebra with a protruding disk. She could as easily have touched the NEXT IMAGE pedal on the floor below the console to advance to the next group of images. To better view the area, Ruth decides to enlarge the region.

Closer inspection of an image

Ruth moves the mouse pointer to the IN box, then moves it over to the slice she wishes to enlarge. Clicking twice, she fills the center screen with a double zoom of the selected slice. Looking around Ruth sees that no staff person is available for a consult, so she decides to mark this view for later analysis by staff. She just isn't sure whether the disk is extending down the canal.
Annotation of case image

Moving the pointer to the seemingly swollen perimeter, she types "Is this definitely a herniation?". As Ruth types, the words appear starting from the pointer arrow, on top of the image. To further highlight the suspected herniation, Ruth uses the region-of-interest markers to place a circle around the suspect area. Ruth now moves the pointer to the ADVANCE box at the top of the screen. This causes a menu to drop down that allows Ruth to instruct RSTAR as to the disposition of the case, and then what to do next. Within this menu she clicks LOG & ADVANCE CASE. This indicates that her reading is complete for now, and that she wishes to continue with the next case. Her annotation, and all other data have been directed to temporary storage until review by staff.

Simply by clicking LOG & ADVANCE CASE Ruth has caused the next CT case to come up for preview.
-> Handling interruptions

No sooner is she beginning to examine the next study than the HIGH PRIORITY chime sounds, indicating that there is a time-critical case needing immediate attention. An EW scan on patient Otto Bangdup, for which Ruth has been waiting the better part of the morning, is finally ready to read. The HIGH PRIORITY CASE dialogue box has simultaneously appeared in the upper right-hand corner, partially covering the current case images, but having no effect on current work.

-> Physician-controlled workflow

The current workscreen disappears when Ruth clicks HANDLE NOW, one of the choices within the box. Now the screen fills with a group of cervical CT images on Otto. Since she wishes a specific pair of views side-by-side, she clicks the PLACEMENT box (in the lower left hand side of the screen). A representation of a multiviewer with a set of miniature CT slices appears. From this multiviewer, Ruth by pointing with the mouse, selects the two slices through the 6th cervical vertebra for closer scrutiny.
-> Manual placement of images

Ruth drags these selected images to the representation of the display screen --monitors-- (upper left hand corner of image-placement-screen) using the mouse, and then clicks the VIEW box (lower right). Immediately the desired life-size images appear on the selected monitor.
- Contrast and window adjustment

To increase the contrast of the tiny fracture lines, Ruth slides the pointer over to the CENTER and WINDOW area (right hand side of screen). By "dragging" the indicators on the CENTER and WINDOW sliders, the image of the fractured vertebral body is brought to a state of unmistakable clarity.
"I wonder whether Sam would like this case for his teaching files", she asks herself, deciding to send him a copy. To do this, she:

1) Selects the desired slices with the mouse. In this case she clicks the display screen containing her annotated and marked images;

2) Writes a memo to Sam with the memo maker available under the Desk-Tools menu;

3) Drags the memo and the selected images over to the Empty-File-Folder. This places a copy of the selected objects into the folder; and

4) Lastly, clicks the DESKTOP box from the header menu (it is always available), and further clicks MAIL. This posts the folder to her friend Sam Secondgues, staff radiologist.

Thus, she ensures Sam will receive it when he checks his mail. I hope he finds it as interesting as I did, she thinks to herself. This whole operation has taken only a few seconds. Otto Bangdu's images are immediately redisplayed, just as she had left them. Later, Ruth will dash off a quick note asking about the unusualness of this type of vein-like fine hairline sign.

Ruth now returns to her stack of work and Sam has a little more to do.